Informed Delivery®
Interactive Mail Campaign Guide

The Purpose of this Document: This guide provides interested mailers with a “how-to” explanation for initiating an Informed Delivery interactive mail campaign.
# Table of Contents

1. **Background** ........................................................................................................................................... 5  
   1.1. Availability ........................................................................................................................................... 5  
   1.2. How It Works for Consumers/Mail Recipients ................................................................................... 5  
   1.3. How It Works for Mailers/Mail Owners .............................................................................................. 6  
2. **Benefits for Mailers** ............................................................................................................................... 8  
3. **Participation Criteria** .............................................................................................................................. 8  
4. **Creating a Campaign** ............................................................................................................................. 8  
   4.1. Levels of Interactive Campaigns ........................................................................................................ 8  
   4.1.1. Mailer ID (MID) .............................................................................................................................. 8  
   4.1.2. Intelligent Mail® Barcode (IMb®) Serialized .................................................................................. 8  
   4.1.3. Personalized .................................................................................................................................... 9  
   4.2. Types of Interactive Campaigns ....................................................................................................... 9  
   4.2.1. Basic Campaign ............................................................................................................................ 9  
   4.2.2. Dual Campaign ............................................................................................................................... 9  
   4.3. Opt-out Indicator Fields ................................................................................................................... 10  
   4.3.1. Target URL Parameters ................................................................................................................ 10  
   4.3.2. Sharing Feature ............................................................................................................................ 11  
   4.3.3. Opt-out Functionality .................................................................................................................. 11  
   4.3.4. Optional Campaign Preview .......................................................................................................... 12  
5. **Campaign Stages and Reporting** .......................................................................................................... 13  
   5.1. Pre-Campaign ..................................................................................................................................... 13  
   5.1.1. Pre-Campaign Analysis Report ..................................................................................................... 13  
   5.2. Campaign .......................................................................................................................................... 14  
   5.3. Post-Campaign ................................................................................................................................... 15  
   5.3.1. Post-Campaign Summary Report .................................................................................................. 15  
   5.3.2. Post-Campaign Detailed Report ................................................................................................... 16  

**Appendices** ............................................................................................................................................... 19  
Appendix A. Interactive Campaign Checklist ............................................................................................... 19  
Appendix B. Mailer ID (MID) and Intelligent Mail® Barcode (IMb®) Information ........................................ 20  
Appendix C. The Mailing Lifecycle ............................................................................................................... 21  
Appendix D. *PostalOne!* Specifications ...................................................................................................... 22  
Appendix E. Formatting Pre-Campaign Analysis File .................................................................................. 24  
Appendix F. Formatting Post-Campaign Detailed Report ........................................................................... 32  
Appendix G. IV-MTR IDPC Data Dictionary ................................................................................................ 34  
Appendix H. Legal Terms & Conditions .................................................................................................... 35
<table>
<thead>
<tr>
<th>Document Version</th>
<th>Section(s) Updated</th>
<th>Change Description</th>
<th>Author</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>All</td>
<td>Initial document created</td>
<td>Carrie Bornitz</td>
<td>02/28/2017</td>
</tr>
<tr>
<td>2.0</td>
<td>Appendix C</td>
<td>Added missing header record and CAT information</td>
<td>Carrie Bornitz</td>
<td>04/03/2017</td>
</tr>
<tr>
<td>2.1</td>
<td>All</td>
<td>Updated language for naming conventions, minimum campaign requirements, and contact info for Program Office and PostalOne! support</td>
<td>Carrie Bornitz</td>
<td>06/20/2017</td>
</tr>
<tr>
<td>2.2</td>
<td>All</td>
<td>Updated document to reflect beta testing of self-serve Mailer Campaign Portal</td>
<td>Carrie Bornitz</td>
<td>09/09/2017</td>
</tr>
<tr>
<td>2.3</td>
<td>All</td>
<td>Updated document with new information regarding the self-serve Mailer Campaign Portal</td>
<td>Carrie Bornitz</td>
<td>12/01/2017</td>
</tr>
<tr>
<td>2.4</td>
<td>All</td>
<td>Updated document to reflect resolved defects; added new Appendices (Pre-campaign and Post-campaign file formatting)</td>
<td>Carrie Bornitz</td>
<td>08/31/2018</td>
</tr>
<tr>
<td>2.5</td>
<td>All</td>
<td>Updated to clarify campaign levels and applying campaigns to groups of customers</td>
<td>Carrie Bornitz</td>
<td>11/19/2018</td>
</tr>
<tr>
<td>2.6</td>
<td>All</td>
<td>Update related to new functionality or fixes</td>
<td>Carrie Bornitz</td>
<td>02/25/2019</td>
</tr>
<tr>
<td>2.7</td>
<td>All</td>
<td>Updated to clarify new submission deadline for interactive campaigns.</td>
<td>Carrie Bornitz</td>
<td>10/04/2019</td>
</tr>
<tr>
<td>2.8</td>
<td>All</td>
<td>Updated to reflect changes to post campaign reporting</td>
<td>Carrie Bornitz</td>
<td>11/22/2019</td>
</tr>
<tr>
<td>2.9</td>
<td>All</td>
<td>Updated with revised Terms &amp; Conditions</td>
<td>Carrie Bornitz</td>
<td>01/14/2020</td>
</tr>
<tr>
<td>3.0</td>
<td>All</td>
<td>Updated with revision to https</td>
<td>Fernando Mello</td>
<td>06/04/2020</td>
</tr>
<tr>
<td>3.1</td>
<td>5.3.3</td>
<td>Updated with addition of 5.3.3 Provisioning IDPC Detailed Data through the IV-MTR Application.</td>
<td>Raqueliza Bernales</td>
<td>05/12/2021</td>
</tr>
<tr>
<td>3.2</td>
<td>4.3</td>
<td>Update related to target URL parameters</td>
<td>Raqueliza Bernales</td>
<td>09/07/2021</td>
</tr>
<tr>
<td>3.3</td>
<td>4.3</td>
<td>Update related to target URL parameters and USPS® mobile app</td>
<td>Raqueliza Bernales</td>
<td>10/14/2021</td>
</tr>
<tr>
<td>3.4</td>
<td>4.3.1</td>
<td>Updates related to improved campaign preview functionality</td>
<td>Raqueliza Bernales</td>
<td>11/09/2022</td>
</tr>
<tr>
<td>Section</td>
<td>Version</td>
<td>Description</td>
<td>Author</td>
<td>Date</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td>3.5</td>
<td>4.1.2</td>
<td>Updates to document title and footers. Added link to IMpb Specification document</td>
<td>Raqueliza Bernales</td>
<td>11/21/2022</td>
</tr>
<tr>
<td>3.6</td>
<td>4.3, Appendix A</td>
<td>Updates related to new functionality or fixes</td>
<td>Raqueliza Bernales</td>
<td>2/15/2023</td>
</tr>
<tr>
<td>3.7</td>
<td>4.3</td>
<td>Updates related to new functionality</td>
<td>Raqueliza Bernales</td>
<td>3/29/2023</td>
</tr>
<tr>
<td>3.8</td>
<td>1.1, Appendix F</td>
<td>Updates related to new eligibility and process</td>
<td>Raqueliza Bernales</td>
<td>5/16/2023</td>
</tr>
<tr>
<td>3.9</td>
<td>1.3, 3, Appendix A, Appendix C</td>
<td>Updated to clarify compatibility requirements</td>
<td>Raqueliza Bernales</td>
<td>9/11/2023</td>
</tr>
</tbody>
</table>
1. **Background**

Informed Delivery is an optional, free feature that gives residential consumers the ability to digitally preview their mail and manage their packages from one convenient location.

- Through Informed Delivery, users/subscribers can view images of letter-size mail and color images from participating mailers via email notification, online dashboard at informeddelivery.usps.com, or USPS Mobile ® app.
- Package tracking information on Priority Mail Express®, Priority Mail®, and other parcels is available as well.
- This feature offers consumers the convenience of seeing what is coming to their mailbox and PO Box—whenever, wherever—even while traveling.

Participating mailers can provide supplemental content, allowing users to take immediate action on a mailpiece.

Informed Delivery “interactive campaigns” or just “campaigns.”

The United States Postal Service (USPS®) currently offers the basic campaign functionality described in this document for no additional fee. Monetization opportunities for additional features are under consideration.

**Figure 1** depicts a sample Informed Delivery email notification—referred to as the “Daily Digest”—with an interactive campaign that is included with the grayscale scanned image of a marketing letter.

Underneath the scanned image is clickable supplemental content, also known as a “Ride-along Image.” The mailer name and a clickable “Learn More” link are provided as part of a basic campaign.

The bottom image illustrates a scanned handwritten letter.

1.1. **Availability**

Informed Delivery is available to eligible residential and business consumers in most ZIP Codes™ across the country. Please note that not every address in a ZIP Code is eligible for Informed Delivery. For instance, a multi-unit building that is not individually identified and coded down to a unique Delivery Point ZIP Code™ at the unit level is not eligible for Informed Delivery.

To check if your address is eligible for Informed Delivery, visit informeddelivery.usps.gov and sign up.

1.2. **How It Works for Consumers/Mail Recipients**

USPS uses existing processes that provide digital images of the exterior of mailpieces as they are processed through automation equipment; those images are used to provide digital notifications to users in advance of the delivery of physical mail. The scanned images can be viewed in a user’s email notification, the USPS Mobile® App, or on the user’s personal dashboard at informeddelivery.usps.com. The process flow is depicted in **Figure 2**.
Figure 3 depicts how a physical mailpiece image (without an interactive campaign) is displayed on the user’s Informed Delivery dashboard. Within the dashboard, mailpiece information is maintained for a period of seven calendar days. Users have the ability to toggle between their “Mailpieces” and “Packages” tabs to preview mailpiece images or to manage and track packages. Learn more about this consumer-facing feature and sign up at informeddelivery.usps.com.

1.3. How It Works for Mailers/Mail Owners

Informed Delivery users will see images of their mail, regardless of whether or not a mailer conducts an interactive campaign. Mailers can enhance their hardcopy mailings by conducting a campaign that includes custom images and a website link (URL). This information will appear in the user’s email digest, the USPS Mobile® App, or on the dashboard at USPS.com®. This supplemental content is referred to as an interactive campaign.

- Each unique set of customized supplemental content is associated with an individual mailing. Multiple interactive campaigns can be conducted at one time for a single mailing. Multiple mailings and campaigns can be conducted simultaneously.
• Each campaign is triggered by and mapped to a single Mailer ID (MID) within an Intelligent Mail® barcode (IMb®) that is used on the mailpiece, customized to be active during a defined date range.
• More information on the MID and the IMb can be found in Appendix B.

![Figure 4. Process flow showing when USPS applies Informed Delivery campaigns](image)

When the Informed Delivery application receives a mailpiece scan for an enrolled Informed Delivery user and the MID or the MID + Serial Number in the IMb is associated with an active mailer campaign, that user will see customized supplemental content that the mailer provided USPS. The process for this is illustrated in Figure 4.

The interactive campaign content is currently displayed below the image in the email and Informed Delivery dashboard, as depicted in Figure 5. USPS is considering additional template designs in the future.

*Disclaimer*: In order for an Informed Delivery campaign to appear in the Daily Digest or on the online dashboard, a full-service Service Type Identifier (STID) is required. Mailpieces without a full-service STID will not be fully processed.

![Figure 5. Informed Delivery dashboard view with an interactive campaign](image)
2. Benefits for Mailers

Informed Delivery allows mailers to:

- Take advantage of a new digital channel, tying hardcopy mail to digital content.
- Receive an additional digital impression for the intended recipient and additional impressions for other household members who are Informed Delivery users.
- Experience high email open rates (over 60% daily average).

Informed Delivery interactive campaigns provide additional benefits, allowing mailers to:

- Enhance the scanned mailpiece images that consumers are already receiving.
- Give the mail recipient or other household members the opportunity to take action immediately on their mailpiece by clicking on a campaign image/website link—regardless of whether or not they retrieve mail from the physical mailbox.
- Coordinate multi-channel campaigns.
- Collect information on campaign reach and results (e.g., open rates, click-through rates) through data analytics.

3. Participation Criteria

Virtually any mailer can conduct an Informed Delivery campaign if the following criteria are met:

- Mailpieces must be automation compatible
  - Available for First-Class Mail®, Periodicals, or USPS Marketing Mail™ letter-size, postcard, or flat-size pieces such as large envelopes, catalogues, and magazines.
- Mailpieces must contain a valid IMb.
- Mailer or Mail Service Provider (MSP) must be IMb certified.

*Disclaimer: For an Informed Delivery campaign to appear, a full-service Service Type Identifier (STID) is required.

*Note: A campaign can be initiated by the mailer or by their designated MSP (advertising agency, printer, freight shipper, presort bureau, etc.).

4. Creating a Campaign

The overall campaign process is simple; mailers create and induct hardcopy mail as usual and provide USPS data elements and supplemental content to facilitate an Informed Delivery interactive campaign. Mailers need to determine the level of campaign they will conduct, the type of campaign, the supplemental content that will be used, the campaign start and end dates, etc. Each of these are described in the sections below.

4.1. Levels of Interactive Campaigns

At this time, there are two levels or breakdowns of campaigns available (Figure 6):

4.1.1. Mailer ID (MID)

All mailpieces with this MID have the same campaign applied, therefore all Informed Delivery users see the same campaign.
Interactive Mail Campaign Guide

- Note: This method cannot be used with shared MIDs.

4.1.2. Intelligent Mail® Barcode (IMb®) Serialized
All mailpieces with the same MID and a defined Serial Number range within the IMb create a unique campaign.

- This campaign level provides the ability to apply different campaigns to groups of customers and the ability to use a “shared” MID, such as one that might be used in large businesses with multiple business units or one provided by a MSP.
- These campaigns are defined with a unique and sequential Serial Number range for each campaign treatment desired.
- Dividing the mailing list into campaign groups prior to printing/addressing the actual mailpieces or assigning the IMb’s is critical.
- See Appendix C. The Mailing Lifecycle or the Intelligent Mail® Package Barcode (IMpb) Specification document for more information on this topic.
- The majority of interactive campaigns are conducted using this level.

<table>
<thead>
<tr>
<th>MID: Apply the same campaign to all customers</th>
<th>IMbSerialized: Apply different campaigns to groups of customers</th>
</tr>
</thead>
</table>

*Figure 6. Illustration of MID and IMb Serialized Campaigns*

### 4.2. Types of Interactive Campaigns

There are two types of Informed Delivery campaigns available.

#### 4.2.1. Basic Campaign

- **Ride-along Image and Target URL - Figure 7**: This campaign includes the USPS grayscale scanned image of a letter-size mailpiece and an image provided by the mailer, currently placed below the grayscale image in the email and dashboard. In all cases, the Ride-along Image is clickable (interactive), as is the additional “Learn More” link. These are both linked to the same URL. All URLs must begin with https. The “Learn More” field name/text is not editable.
  - Important Notes: A Ride-along Image and URL are required to conduct an Informed Delivery campaign. All URLs must lead directly to a landing page directly associated with the physical mailpiece. See our Informed Delivery Interactive Campaign Mailer/Submitter Terms and Conditions for full details.

#### 4.2.2. Dual Campaign
Representative Image, Ride-along Image, and Target URL - Figure 8: In addition to the required Ride-along Image and URL, this campaign type includes an image that is provided in lieu of a flat-size image or in place of a grayscale letter-size image. (Grayscale images of flat-size mail are not provided to consumers, however, scan events are captured for some flat-sized mailpieces during processing.)

- Representative Images are static; they are not clickable/interactive.
- These images must be clearly branded and must be clearly and directly related to the hardcopy mailpiece. See our Informed Delivery Interactive Campaign Mailer/Submitter Terms and Conditions for full details.

4.3. Opt-out Indicator Fields

4.3.1. Target URL Parameters

Informed Delivery has released a system update to send campaign Mailer ID (MID) and Serial Number information in the form of URL parameters when consumers click on interactive campaign Target URLs. This update enables additional data to be captured, allowing mailers to better understand Informed Delivery driven referrals. Additionally, this update enables Target URL webpages to be dynamic based on campaign MID and Serial Number.

Please be advised, the URL parameters may not be compatible with all campaign Target URLs. Webpage redirects may not function properly when Informed Delivery passes the parameters. If the URL being used in the campaign is a redirect, the end destination URL must be entered as the Target URL for the interactive campaign. The Campaign Parameters PDF on the Informed Delivery for Business Mailers & Shippers website contains...
information about the function of the campaign URL opt-in/out-out feature.

It’s recommended that URLs are tested in the Mailer Campaign Portal (MCP) prior to campaigns being submitted (Figure 9).

**Figure 9. Sample Target URL with parameters**

```
https://www.brandname.com/usps_mid=123456&usps_sn=123456789
```

4.3.2. Sharing Feature

The Informed Delivery Sharing feature enables users to send referrals and share campaign links via email, text, or social media from the Daily Digest email. A referral banner appears at the top of the Daily Digest, prompting users to share Informed Delivery via text or email. Icons appear alongside campaigns that have been opted-in for social sharing.

4.3.3. Opt-out Functionality

In the campaign “Build” Phase, mailers can opt-out of Informed Delivery URL parameters and Social Sharing when submitting a campaign via the Mailer Campaign Portal (MCP). Currently, all the test link functionality within the MCP adheres to the opt-in/out selection (Figure 10). When the email preview or campaign “proof,” is sent from the MCP via the “Send Preview” button (Figure 11), the campaign preview includes the opt-out selection for the URL parameter feature.
4.3.4. Optional Campaign Preview

An optional Campaign Preview is available from the Review page.

- Select the “Campaign Preview” button at the of the page.
  
  - Select “Send Preview” and enter up to five email addresses to send this digital preview email notification to yourself or others in your organization. Note: A maximum of five campaign preview emails is allowed per campaign code, per day.
  
  - Currently, preview emails contain a campaign identifier in the subject line of the email to distinguish between campaigns and a “Test Only” banner to ensure the email is more distinguishable as a preview email and not a real Daily Digest email (Figure 12)
  
- View a digital preview of the campaign on a mockup of a consumer’s dashboard by selecting the “Consumer Dashboard” option at the top of the screen.

![Figure 11. Mailer Campaign Portal Campaign Preview](image)

*Figure 11. Mailer Campaign Portal Campaign Preview*

*Figure 12. Mailer Campaign Preview Email Notification*
5. Campaign Stages and Reporting

There are three basic stages in the campaign process: Pre-Campaign, Campaign, and Post-Campaign.

5.1. Pre-Campaign

This defines the process of gathering the required campaign elements and determining the submission method as described in Section 4. For an overview of how to conduct a campaign in seven simple steps, see the Interactive Campaign Checklist in Appendix A. Interactive Campaign Checklist.

5.1.1. Pre-Campaign Analysis Report

USPS offers an optional Pre-Campaign Analysis report. For this analysis, USPS cross-references an uploaded list against a current Informed Delivery user list and provides an aggregate response indicating how many consumers in the list are Informed Delivery users—at a given point in time. This information is provided in aggregate as USPS is prohibited from providing lists of Informed Delivery users. Pre-Campaign files can be submitted at any time, even after a campaign has been activated.

The Pre-Campaign list/file must contain 11-digit Delivery Point ZIP Codes that are taken from the IMb of a recent mailing list. MSP’s are most commonly able to provide this information from the IMb. This delivery point information is not stored in standard customer databases.

The file must meet the criteria below:

- The header must read ZIP11.
- Each entry must be an 11-Digit Delivery Point ZIP Code.
  - To delete line items without 11-digit codes, import the file containing the codes into Excel. Once in Excel, filter the data based on length, delete the non-11 digit codes, and save the document in .csv format.
- Include leading zeroes.
- Remove duplicate codes.
- Save as a Comma Separated Values (.csv) file (using lowercase .csv).
- Break files into 102,400 KB (or 100MB) or less.

Figure 1 provides an example of how the Pre-Campaign file will look once it is ready for uploading in the MCP. If the file does not meet these criteria, it will not be uploaded or processed.

Regardless of the intended campaign submission method, use the MCP to upload the properly formatted ZIP11 .csv file. See the Mailer Campaign Portal User Guide on the Informed Delivery for Business Mailers website for details on how to upload a file.
• If an invalid file is uploaded in the Portal, the mailer will receive an error message explaining the file issue(s) that prevented a successful upload.
• The report will be provided within the Portal when it is done processing. Processing time varies based on the file size.

**Important Note:** To verify the contents of the Pre-Campaign data, right-click the file and open with a text editor such as Notepad. **Appendix E. Formatting Pre-Campaign Analysis File** outlines the step-by-step process for ensuring that the Pre-Campaign file is correctly formatted.

The completed Pre-Campaign Analysis report, which is provided in the Portal, includes the following data:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Pre-Campaign List Size</td>
</tr>
<tr>
<td>B</td>
<td>Eligible 11-digit Delivery Point ZIP Codes</td>
</tr>
<tr>
<td>C</td>
<td>Unique Eligible 11-digit Delivery Point ZIP Codes</td>
</tr>
<tr>
<td>D</td>
<td># of Subscribers</td>
</tr>
<tr>
<td>E</td>
<td>Subscriber Saturation (%)</td>
</tr>
<tr>
<td>F</td>
<td># of Email Enrolled Subscribers</td>
</tr>
<tr>
<td>G</td>
<td>Email Enrolled Saturation (%)</td>
</tr>
</tbody>
</table>

![Figure 14. Pre-Campaign Analysis Report](image)

### 5.2. Campaign

Campaigns are activated based on the requirements provided by the mailer/MSP, which are dictated by the campaign data elements—as described in Section 4.

The start date of the campaign, duration of the campaign, and campaign images that are provided result in the campaign being applied to each mailpiece, based on the information in
In relation to the campaign elements, only the Brand/Campaign Display Name and supplemental content are presented to the Informed Delivery user. The other campaign elements provided are used in the background, to apply the appropriate campaign for the defined time period.

5.3. **Post-Campaign**

USPS understands that data analysis is important to measuring success and determining where to direct marketing funds and resources. The Post-Campaign Summary and Detailed reports provide a wealth of information related to an individual campaign.

5.3.1. **Post-Campaign Summary Report**

This report provides the general aggregated results of an individual campaign, including the number of users/mail recipients that were sent an email, the email open rate, and the number of click-throughs.

- For campaigns submitted through the Mailer Campaign Portal (MCP) or *PostalOne*, post-campaign reports are available for download via the Portal.
- Post-campaign reports run daily in the morning rather than on-demand by mailer request. Reports are cumulative and encompass all campaign activity through the report date.

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Campaign_Display_Name</td>
</tr>
<tr>
<td>B</td>
<td>Campaign_Title</td>
</tr>
<tr>
<td>C</td>
<td>Campaign_Code</td>
</tr>
<tr>
<td>D</td>
<td>Mailpieces</td>
</tr>
<tr>
<td>E</td>
<td>Emails</td>
</tr>
<tr>
<td>F</td>
<td>Email_Open</td>
</tr>
</tbody>
</table>
Interactive Mail Campaign Guide

**G** Email_Open_Rate  
The number of email opens divided by the number of emails (Col F/E).  
- This metric can seem irregularly high (e.g., over 100%) if organizations look at it on a daily or regular basis, as opposed to holistically over the entire life span of a campaign. This can happen if users who receive their mailpiece do not open their email until a later date/time.

**H** Click_Through  
The number of click-throughs generated from emails, dashboard, or USPS Mobile® app. Filter column "RECORD_TYPE" within the detailed report for "Click Details" to show total clicks. Count every row to show the total number of clicks. This will match the Click_Through column in the summary report.

**I** Click_Through_Rate  
The number of click throughs divided by the number of mailpieces (Col H/D).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC CO</td>
<td>1A.1698</td>
<td>ABC CO July 2015</td>
<td>10096</td>
<td>5576</td>
<td>3676</td>
<td>66.0%</td>
<td>29</td>
<td>0.29%</td>
</tr>
</tbody>
</table>

*Figure 15. Post-Campaign Summary Report*

**5.3.2. Post-Campaign Detailed Report**

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Brand_Display_Name</td>
<td>The name displayed in the “From” field of the campaign (sometimes referred to as Campaign Display Name or Display Name).</td>
</tr>
<tr>
<td>B Mailer_ID</td>
<td>The six-digit or nine-digit numeric code that was submitted for the campaign.</td>
</tr>
<tr>
<td>C Campaign_Code</td>
<td>A mailer-generated unique code for a campaign.</td>
</tr>
<tr>
<td>D Campaign_Title</td>
<td>A mailer-generated title for a campaign.</td>
</tr>
<tr>
<td>E Submitter_CRID</td>
<td>A Customer Registration Identification (CRID) is a USPS-generated numeric code of up to 15 digits that uniquely identifies a USPS customer at a location.</td>
</tr>
<tr>
<td>F Start_Date</td>
<td>The start date of the campaign as specified by the mailer. The campaign start date cannot be set for more than 60 days in the future.</td>
</tr>
<tr>
<td>G End_Date</td>
<td>The end date of the campaign as specified by the mailer. The cut-off is at 12AM of the end date. Mail processed on the campaign end date will not be included in any reports.</td>
</tr>
<tr>
<td>H Start_Serial</td>
<td>If the campaign is based on IMb Serialized (not MID level) – indicates asix- or nine-digit starting Serial Number.</td>
</tr>
<tr>
<td>I End_Serial</td>
<td>If the campaign is based on IMb Serialized (not MID level) – indicates a six-digit or nine-digit ending Serial Number.</td>
</tr>
<tr>
<td>J MID_Serial</td>
<td>The full 15-digit MID and the IMb Serial Number of that specific mailpiece.</td>
</tr>
<tr>
<td>K</td>
<td>ZIP5</td>
</tr>
<tr>
<td>L</td>
<td>Mailpiece_ID</td>
</tr>
<tr>
<td>M</td>
<td>Delivery_Date</td>
</tr>
<tr>
<td>N</td>
<td>Email_ID</td>
</tr>
<tr>
<td>O</td>
<td>WhenWasEmailSent</td>
</tr>
<tr>
<td>P</td>
<td>WhenWasEmailOpened</td>
</tr>
<tr>
<td>Q</td>
<td>ImagePositionInEmail</td>
</tr>
<tr>
<td>R</td>
<td>WhenClickedThrough</td>
</tr>
<tr>
<td>S</td>
<td>Source</td>
</tr>
<tr>
<td>T</td>
<td>Record_Type</td>
</tr>
</tbody>
</table>

**Figure 16. Post-Campaign Detail Report** (shown as two separate images due to file width, without formatting)

For additional information on campaign report access and other campaign related information, visit the Informed Delivery for Business Mailers website. Our full listing of known report issues/defects is in Informed Delivery® Mail Tracking and Reporting (IV®-MTR). To expand on capabilities offered by the Mailer Campaign Portal (MCP), Informed Delivery integrated with IV-MTR. The feature offers the following:

- Near real-time data, provided as soon as its available (recurring data feed)
- Two options for receiving data: one-time queries or data feeds
- Data access delegation is available at the MID or CRID level
Interactive Mail Campaign Guide

Please note that Informed Delivery Post-Campaign (IDPC) is pass-through and not generated by IV-MTR.

To find additional resources and information:

- Appendix G: Data Dictionary for IV-MTR IDPC Reporting
- PostalPro™ IV-MTR site
- IV User Guide: Provisioning IDPC Data in IV-MTR

For general questions on IV-MTR, please contact the Informed Delivery helpdesk. For questions on the IV-MTR application, please go to the IV Solutions Center at 1-800-238-3150 (Option 2) or InformedVisibility@usps.gov.
## Appendix A. Interactive Campaign Checklist

Follow these steps to create an Informed Delivery interactive campaign:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | Choose your campaign submission method (Section 4.5):  
  - *PostalOne®* – Contact the *PostalOne!* team at [USPSInformedDeliveryDoc@usps.gov](mailto:USPSInformedDeliveryDoc@usps.gov) to get started. |
| 2.   | Determine campaign level and mailing list breakdown (Section 4.1):  
  - Apply a single Informed Delivery campaign to all mailpieces/customers.  
  - Apply different campaign treatments to different customers in the same or different mailings.  
  - At this time, also assign a Campaign Title and Campaign Code to the interactive campaign and define the mailpiece shape: letter, card, or flat. |
| 3.   | Determine MID on Piece and, if relevant, the IMb Serial Number Range (Section 4.1):  
  - MID can belong to the mail owner, ad agency, printer, or other Mail Service Provider (MSP).  
    - Existing MIDs can be used; full service IMb is required.  
    - MID must be printed in the IMb on the mailpieces.  
  - Gather Start and End IMb Serial Number Ranges – if doing IMb Serialized campaigns, a unique and sequential range is required for each campaign or treatment. |
| 4.   | Develop supplemental content (Section 4.2):  
  - Design creative for your Ride-along Image (required).  
  - Determine your target URL (required).  
  - Decide if you want to keep the grayscale mail processing image or use a color Representative Image (optional for letters/postcards) |
| 5.   | Determine campaign timeline (Section 4.5):  
  - USPS suggests a Start Date of 2-3 days prior to your first expected in-home date.  
  - USPS suggests an End Date 2-3 days after your last expected in-home date. |
| 6.   | Submit campaign (Section 4.5):  
  - Mailer Campaign Portal – Enter your campaign details and supplemental content within the portal.  
  - *PostalOne!* – Submit campaign(s) using Mail.dat or Mail.xml. |
| 7.   | Analyze Results (Section 5):  
  - Download Post-Campaign Analyses directly in the Portal (regardless of submission method).  
    - Summary Report – Download information regarding the number of physical mailpieces, number/percentage of emails opened, and number/percentage of click-throughs.  
    - Detailed Report – Download detailed information, such as the time stamp of when a user opened an email.  
  - Retrieve mail tracking data as a one-time query or recurring data feed using Informed Visibility® Mail Tracking and Reporting (IV®-MTR) – Enroll through the Business Customer Gateway (BCG) and IV-MTR Websites |
Appendix B. Mailer ID (MID) and Intelligent Mail® Barcode (IMb®) Information

The IMb on the mailpiece, and the contents within it, are the key to getting mailpiece images to users and activating Informed Delivery interactive campaigns.

- The IMb is comprised of five fields: Barcode ID, Service Type ID (STID), MID, Serial Number, and Delivery Point ZIP Code. These fields provide intelligence such as mail class, service requested, mailer identification, and unique Serial Number tracking.
  - For the purposes of Informed Delivery, we only use the last 3 fields of the IMb (not the BI or the STID).
- Grayscale scanned images are linked to Informed Delivery users based on the Delivery Point Code (DPC) field within the IMb. This is the nine-digit ZIP Code plus a two-digit Delivery Point Code value.
- Only consumers/mail recipients that reside in dwellings that have a unique 11-digit Delivery Point Code can participate in Informed Delivery; this also applies to multi-unit dwellings.

- Campaign images and URLs (supplemental content) are linked to each individual mailpiece processed based on the MID in the Intelligent Mail Barcode (IMb) on the actual mailpiece.
  - A MID provided in electronic postage statement documentation (PostalOne! eDoc) has no impact on the Informed Delivery campaign. See Appendix D, PostalOne! Specifications for PostalOne! programming and submission information.

<table>
<thead>
<tr>
<th>Type</th>
<th>Field</th>
<th>Field Length (Digit)</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracking Code</td>
<td>Barcode Identifier (BI)</td>
<td>2</td>
<td>Identifies source as Postal or Mailer as well as applicable presort level</td>
</tr>
<tr>
<td></td>
<td>Service Type Identifier (STID)</td>
<td>3</td>
<td>Identifies services requested on mailpiece</td>
</tr>
<tr>
<td></td>
<td>Mailer ID (MID)</td>
<td>6 or 9</td>
<td>Assigned by the Postal Service to identify business entity or customer</td>
</tr>
<tr>
<td></td>
<td>Serial Number</td>
<td>9 or 6</td>
<td>9 (when used with a 6 digit Mailer ID) 6 (when used with a 9 digit Mailer ID)</td>
</tr>
<tr>
<td>Routing Code</td>
<td>Delivery Point ZIP Code</td>
<td>None, 5, 9, or 11</td>
<td>Used to route the mail to its final delivery point</td>
</tr>
</tbody>
</table>

Figure 17. Excerpt from IMb 4-State manual (Rev H, 4/20/2015, Page 52)
Appendix C. The Mailing Lifecycle

There are generally many different people involved in the daily mailing operations of sending invoices and insurance documents, staying in touch with customers, or creating and conducting a Direct Mail campaign. Input on decisions related to campaigns can come from key stakeholders throughout the company, such as Finance, IT, Marketing, Data Analytics, Legal, Accounting, etc.

![Figure 18]

Additionally, there are many companies that provide support for day-to-day mailing operations or Direct Mail marketing campaigns. Mail Service Providers (MSPs) support mail owners with mail printing, addressing, barcoding, sorting, distribution, and/or commingling. Ad Agencies support mail owners with media decisions, campaign creative, mailpiece design, and more.

Organizations should involve key stakeholders and support teams in the development cycle of an Informed Delivery interactive campaign too.

Since the MID or, more commonly, the MID + IMb Serial Number on the mailpiece is key to activating a campaign, the person responsible for this data element is critical to campaign success. Properly segregating your mailing list prior to assigning the IMb or placing it on the mailpieces is key.

**Example:** A company is mailing to 15,000 customers. This company uses a single six-digit MID. The company wants to determine, between three different mailpieces, which mailpiece receives the best response rate. The company creates a unique vanity URLs for each of the three mailpieces to track visits and determine which mailpiece drove the most engagement.

To apply a different Informed Delivery campaign to each mailpiece type (or groups of customers), the company needs to ensure that their mailing list is broken out into three separate/unique lists (IMb Serial Numbers). By doing so, the company can apply three unique Informed Delivery campaigns, each with its own supplemental content (Ride-along and/or Representative Image, and URL). The company should check to ensure that the Serial Number printed on the mailpiece corresponds to the appropriate Informed Delivery campaign.

![Figure 19. Illustration of mailing list breakdown for Informed Delivery campaign use]
Appendix D. PostalOne! Specifications

Mailers using the PostalOne! Mail.dat or Mail.xml file formats are able to submit Informed Delivery interactive campaign information electronically.

- The Informed Delivery Mail.dat or Mail.xml files are sent as part of a larger Mail.dat or Mail.xml job that contains presort and postage statement information; other presort and postage supporting files are also submitted along with the Informed Delivery files.

Documents regarding the specific programming requirements and processes for PostalOne! campaign submissions are provided as links on the Informed Delivery for Business Mailers website. An overview of the required PostalOne! onboarding can be found below.

PostalOne! Onboarding & Contact Information

All mailers that wish to conduct/submit campaigns using PostalOne! are required to work with the PostalOne! Customer Acceptance Testing (CAT) office for Informed Delivery interactive campaigns. This PostalOne! team can be reached directly by emailing USPSInformedDeliveryeDoc@usps.gov

PostalOne! Onboarding Check List

Follow the steps outlined below to set up your Customer Acceptance Testing (CAT) Business Customer Gateway (BCG) account and conduct an Informed Delivery campaign using PostalOne!:

- Email the Informed Delivery eDoc team at USPSInformedDeliveryeDoc@usps.gov stating initial intent to start testing Informed Delivery Campaigns using PostalOne!. Please provide the following information:
  - Point of contact name
  - Phone number
- Coordinate with USPS to determine if the mailer submitting the campaign has participated in PostalOne! Customer Acceptance Testing (CAT) in the past.
- If the organization has participated in PostalOne! CAT, please acquire the PostalOne! CAT credentials below. These credentials will allow the organization to create a Mail.dat eDoc job for an Informed Delivery campaign.
  - Username
  - Password
  - Customer Registration ID (CRID)
  - Mailer ID (MID)
  - Permit account number
  - ZIP Code™ related to the Permit

Set Up Your PostalOne! CAT Account with Permit

1. Visit the USPS BCG CAT environment.
2. Create a BCG account:
   a. Click on “Register for Free.”
   b. Choose a username and password.
   c. Provide security information.
   d. Provide phone and email contact information.
   e. Provide company name, information, and address.
i. A BCG Business Account will be granted upon completion of these fields. The user will be automatically assigned a mailer CRID and MID. Those credentials appear on-screen within the application and will be sent to the registered email address on file.

3. Email the Informed Delivery eDoc team the following information:
   a. CRID
   b. MID
   c. Company name, address, and point of contact

4. Request that a Permit Imprint Postage Payment Account be created and activated.
   a. **Note:** The Permit should be funded with a large test balance amount so that Mail.dat jobs with postage and campaign data can be submitted.

5. Once the CAT BCG account has been created, the CAT office will link the newly created Permit to the mailer test CRID.

6. The CRID, MID, and Permit Account Number information can now be used to prepare and submit Mail.dat jobs with Informed Delivery campaigns to *PostalOne!* CAT.

7. The *PostalOne!* CAT Mail.dat client can be downloaded from the *PostalOne! BCG CAT page* after logging in.

8. The Informed Delivery eDoc team will validate the eDocs data and provide feedback if data needs to be corrected to be eligible for production environment.

Any questions or information related to *PostalOne!* or the process outlined above can be sent to the Informed Delivery eDoc team.

All general campaign questions related to supplemental content specifications, reporting, etc., must be directed to the USPSInformedDeliveryCampaigns@usps.gov email.
### Appendix E. Formatting Pre-Campaign Analysis File

To run a Pre-Campaign Analysis, the following file formatting requirements must be met or the file upload will fail:

- The column header must read ZIP11.
- Each entry must be an 11-Digit Delivery Point ZIP Code. Any entry that is not an 11-Digit Delivery Point ZIP Code should be deleted.
- Include leading zeroes.
- Remove duplicate codes.
- Save as a Comma Separated Values (.csv) file (using lowercase .csv).
- Break files into 102,400 KB (or 100MB) or less.

The following steps will provide guidance on how to format your Pre-campaign analysis file correctly, including how to:

- Extract the 11-digit Delivery Point Codes (DPC) from IMb’s, and;
- Confirm that every entry contains only 11-digit DPCs.

11-digit DPCs are a key part of the Intelligent Mail Barcode (IMb). There are five fields in the IMb— the DPC is in the last/fifth field (see Appendix B. Mailer ID (MID) and Intelligent Mail® Barcode (IMb®) Information). The easiest way to identify DPCs is from a recent mailing that was conducted. The printer/vendor should have access to this data. Keep in mind that most customer databases do not store DPCs.

**1. Extract DPCs out of an IMb to prepare the Pre-Campaign Analysis file.**

1.1. Open the IMb file in Notepad to ensure you have only IMb’s in the file, and save it to your computer.

1.2. Open a new instance of Microsoft Excel, and import the Text file by following the steps below.
1.2.1 Open the Data tab, and then select “From Text” in the “Get External Data” section. Note: If you are working in Excel 2016 in O365 or later, the Text Import Wizard (below) may no longer be enabled. To enable it, navigate to File > Options > Data and select “From Text (Legacy)” under the “Show legacy data import wizards” section.

1.2.2 Select the file that contains your IMb’s and click “Import.” The Text Import Wizard will appear.

1.2.3. Using your mouse, click to the right of the first two characters of the numbers showing in the “Data preview” section. This will insert an arrow as shown below. Repeat this step four more times to insert these arrows in between each of the five IMb sections. Select “Next.” Important Note: Your MID could be six or nine digits in length—and your IMb Serial Number is also six or nine digits long. It is imperative that you know the MID used before you complete this step.
1.2.4. Select “Text” under Column data format. Then, select “Finish.”

1.2.5. An Import Data window will appear. Select “Existing Worksheet” to indicate how you want to view this data in your workbook (default option).

1.2.6. Content will be imported into Excel into five columns. The fifth column (Column E) contains the 11-digit DPC.

1.3. Delete columns A through D. Keep column E
2. Verify if the .CSV File is properly formatted for submission in the Mailer Campaign Portal.

2.1. Open a new Excel file.

2.2. Open the Data tab, then select “From Text” in the “Get External Data” section.

2.3. Select the file that contains your 11-digit Delivery Point Barcodes from your IMb’s; select “Import.”

2.4. Leave the delimiters as is (“Tab”). Click “Next.”

2.5. Select “Text.”

2.6. The data will import into your Excel document.
2.7. Insert “ZIP11” as a header to cell A1 without quotation marks. This is a required column header.

2.8. Label column B “Length” and enter the following formula into cell B2: =len(A2).

2.9. Copy the formula to each row by re-selecting B2 and double-clicking the green square at the bottom right of the cell.
2.10. Highlight the two column headers and press Ctrl+Shift+L to enable filters; then, filter the Length column to only display lengths that do not equal 11.

2.11. Highlight and delete all of the rows displayed in the filter.

2.12. Remove the filter to display the remaining rows, which should all have a length of 11.
2.13. Delete the Length column and save the file in .CSV format.

3. Select all of the entries below the ZIP11 column header

3.1 Click on the “Data” tab and click on the “Remove Duplicates” button under Data Tools.

3.2 Click “OK” when the Remove Duplicates window appears.
3.3 Click “OK” to accept the removal of duplicates and save the file to your computer as a .csv file.

Ensure that your file does not exceed 102,400 KB. Your file is now ready for upload to the Mailer Portal.

3.5 Proceed to the Mailer Campaign Portal to upload your file.
Appendix F. Formatting Post-Campaign Detailed Report

1. If some of the columns in the campaign report appear in scientific notation and cannot be resolved by changing the format to a number, click the “Download Report” link from the Mailer Campaign Portal, and select “Save As.”

   *Note, do not open the file or view it in Excel. If you open the file in Excel, formatting options will be limited.

   **Downloading a campaign report from the Mailer Campaign Portal**

2. Open a new blank sheet in Excel. In the Data tab, select “From Text/CSV” and upload the data file that you saved in the previous step and click “Import”.

3. For data that appears in scientific notation, select the column(s) you wish you change and select “Data Type: Whole Number” from the top ribbon.
## Appendix G. IV-MTR IDPC Data Dictionary

A detailed version of the IV-MTR IDPC Data Dictionary can be found on the [IV-MTR PostalPro](https://www.postalpro.com) website.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
<th>Sample Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode Identifier</td>
<td>Barcode Identifier of the mailpiece IMB Code</td>
<td>01</td>
</tr>
<tr>
<td>Barcode Mailer ID</td>
<td>Barcode Mailer ID of the mailpiece IMB Code</td>
<td>123456</td>
</tr>
<tr>
<td>Barcode Serial Number</td>
<td>Serial Number of the mailpiece IMB Code</td>
<td>990019102</td>
</tr>
<tr>
<td>Brand Display Name</td>
<td>The name displayed in the “From” field of the campaign</td>
<td>ABC Company</td>
</tr>
<tr>
<td>Campaign Code</td>
<td>A mailer generated unique code for a campaign</td>
<td>ABC July 2020</td>
</tr>
<tr>
<td>Campaign Title</td>
<td>A mailer generated title for a campaign</td>
<td>ABC071020</td>
</tr>
<tr>
<td>Delivery Date</td>
<td>The date that a mailpiece was processed for delivery</td>
<td>2020-01-01</td>
</tr>
<tr>
<td>eDocSubmitter CRID</td>
<td>USPS-generated numeric code of up to 15 digits that uniquely identifies a USPS EDOC (for PO! campaigns only)</td>
<td>4614860</td>
</tr>
<tr>
<td>eDocSubmitter Name</td>
<td>The name of the organization that submitted the electronic documentation to the postal service for mailing.</td>
<td>ABC Company</td>
</tr>
<tr>
<td>Email ID</td>
<td>A unique identifier for each mailpiece. Automatically generated by USPS</td>
<td>1587469</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date of the campaign as specified by the mailer. The cut-off is at 12 AM of the end date. Mail processed on the campaign end date will not be included in any reports.</td>
<td>2020-08-30</td>
</tr>
<tr>
<td>End Serial</td>
<td>If the campaign is based on IMb Serialized (not MID level) – indicates a six-digit or nine-digit ending Serial Number.</td>
<td>987456124</td>
</tr>
<tr>
<td>Image Position in Email</td>
<td>The position in which the image was displayed in an email (1 means it was the first image, 2 means it was the second image, etc.)</td>
<td>3</td>
</tr>
<tr>
<td>Mail Owner CRID</td>
<td>USPS-generated numeric code of up to 15 digits that uniquely identifies a USPS Mail Owner (for PO! campaigns only)</td>
<td>222342884</td>
</tr>
<tr>
<td>Mail Owner Name</td>
<td>The name of the organization that owns the mail being sent.</td>
<td>ABC Company</td>
</tr>
<tr>
<td>Mail Preparer CRID</td>
<td>USPS-generated numeric code of up to 15 digits that uniquely identifies a USPS Mail Preparer (for PO! campaigns only)</td>
<td>222342889</td>
</tr>
<tr>
<td>Mail Preparer Name</td>
<td>The name of the organization that prepared the mailing and/or delivered it to the postal service for mailing.</td>
<td>ABC Company</td>
</tr>
<tr>
<td>Mailer ID</td>
<td>The six-digit or nine-digit numeric code that was submitted for the campaign (for all campaigns)</td>
<td>987546321</td>
</tr>
<tr>
<td>Mailer Name</td>
<td>The name of the owner of the MID that's on the mailpiece IMB</td>
<td>ABC Company</td>
</tr>
<tr>
<td>Mailpiece ID</td>
<td>A unique identifier for each piece. Automatically generated by USPS</td>
<td>1254789122</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Service Type Code</td>
<td>Service Type Code of the mailpiece IMB Code</td>
<td>011</td>
</tr>
<tr>
<td>Source</td>
<td>Where the click-through originated. Includes the following: RIDEALONG_WEBSITE - click-through originated from the Learn More link on the dashboard RIDEALONG_WEBSITE_IMAGE - click-through originated from the campaign image on the dashboard RIDEALONG_EMAIL - click-through originated from the Learn More link in the Daily Digest RIDEALONG_EMAIL_IMAGE - click-through originated from the campaign image in the Daily Digest</td>
<td>RIDEALONG_WEBSITE</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of the campaign as specified by the mailer</td>
<td>2020-08-30</td>
</tr>
<tr>
<td>Start Serial</td>
<td>If the campaign is based on IMb Serialized (not MID level) – indicates a six- or nine-digit starting Serial Number.</td>
<td>987456120</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the campaign. Includes the following: ACTIVE, COMPLETE, CANCELLED.</td>
<td>ACTIVE</td>
</tr>
<tr>
<td>Submitter CRID</td>
<td>USPS-generated numeric code of up to 15 digits that uniquely identifies a USPSSubmitter (for all campaigns)</td>
<td>123456</td>
</tr>
<tr>
<td>When clicked through</td>
<td>The time stamp of when a link from a campaign was clicked using the local time</td>
<td>2020-05-14 01:32:36-0400</td>
</tr>
<tr>
<td>When email was opened</td>
<td>The time stamp of when an email was opened using the local time</td>
<td>2020-05-14 01:30:36-0400</td>
</tr>
<tr>
<td>When email was sent</td>
<td>The time stamp of when an email was sent using the local time</td>
<td>2020-05-14 01:00:36-0400</td>
</tr>
<tr>
<td>ZIP5</td>
<td>The ZIP Code of the subscriber (recipient)</td>
<td>12345</td>
</tr>
<tr>
<td>Record Type</td>
<td>Identifies the type of record being provisioned. Includes the following: Non-Email - details for pieces that are not sent in emails Open Details - details for click tracks Click Details - details for click tracks Email - details for emails sent Piece - details for mailpieces associated to campaigns Status - details for campaign status updates</td>
<td>Piece</td>
</tr>
</tbody>
</table>

**Appendix H. Legal Terms & Conditions**

Please navigate to the [Informed Delivery for Business Mailers](https://www.informeddelivery.com) website to find the latest [Informed Delivery Interactive Campaign Mailer/Submitter Terms and Conditions](https://www.informeddelivery.com).